
 

 

 

 
 

 

Agilent Microwave 
Plasma Atomic 
Emission 
Spectrometers 
 
For models 4100, 4200,  
and 4210 

 
 User’s Guide 

 



 

2 Agilent Microwave Plasma Atomic Emission Spectrometers User’s Guide 

Notices 
© Agilent Technologies, Inc. 2011, 
2013, 2016, 2018 

No part of this guide may be 
reproduced in any form or by any 
means (including electronic storage 
and retrieval or translation into a 
foreign language) without prior 
agreement and written consent from 
Agilent Technologies, Inc. as governed 
by United States and international 
copyright laws. 

Guide Part Number 
G8000-90002 

Edition 
Fourth edition, July 2018 

Agilent Technologies Australia [M] Pty 
Ltd 

679 Springvale Road, Mulgrave, 
Victoria, Australia. 3170 

www.agilent.com 

Printed in Malaysia 

Agilent products must only be used in 
the manner described in the Agilent 
product user guides. Any other use 
may result in damage to the product 
or personal injury. Agilent is not 
responsible for any damages caused, 
in whole or in part, by improper use of 
the products, unauthorized alterations, 
adjustments or modifications to the 
products, failure to comply with 
procedures in Agilent product user 
guides, or use of the products in 
violation of applicable laws, rules or 
regulations.  

Agilent shall not be liable for errors or 
damages on products or performance 
due to using non-Agilent genuine 
parts. 

Warranty 
The material contained in this 
document is provided “as is,” and is 
subject to being changed, without 
notice, in future editions. Further, to 
the maximum extent permitted by 
applicable law, Agilent disclaims all 
warranties, either express or implied, 
with regard to this guide and any 
information contained herein, 
including but not limited to the 
implied warranties of merchantability 
and fitness for a particular purpose. 
Agilent shall not be liable for errors 
or for incidental or consequential 
damages in connection with the 
furnishing, use, or performance of 
this document or of any information 
contained herein. Should Agilent and 
the user have a separate written 
agreement with warranty terms 
covering the material in this 
document that conflict with these 
terms, the warranty terms in the 
separate agreement shall control. 

Technology Licenses 
The hardware and/or software 
described in this document are 
furnished under a license and may be 
used or copied only in accordance 
with the terms of such license. 

Restricted Rights Legend 
If software is for use in the 
performance of a U.S. Government 
prime contract or subcontract, 
Software is delivered and licensed as 
“Commercial computer software” as 
defined in DFAR 252.227-7014 (June 
1995), or as a “commercial item” as 
defined in FAR 2.101(a) or as 
“Restricted computer software” as 
defined in FAR 52.227-19 (June 1987) 
or any equivalent agency regulation or 

contract clause. Use, duplication or 
disclosure of Software is subject to 
Agilent Technologies’ standard 
commercial license terms, and non-
DOD Departments and Agencies of the 
U.S. Government will receive no 
greater than Restricted Rights as 
defined in FAR 52.227-19(c)(1-2) (June 
1987). U.S. Government users will 
receive no greater than Limited Rights 
as defined in FAR 52.227-14 (June 
1987) or DFAR 252.227-7015 (b)(2) 
(November 1995), as applicable in any 
technical data. 

Safety Notices 

A CAUTION notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, if 
not correctly performed or adhered to, 
could result in damage to the product 
or loss of important data. Do not 
proceed beyond a CAUTION notice 
until the indicated conditions are fully 
understood and met. 

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or the 
like that, if not correctly performed 
or adhered to, could result in 
personal injury or death. Do not 
proceed beyond a WARNING notice 
until the indicated conditions are 
fully understood and met. 

WARNING 

CAUTION 
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General 
Unless otherwise specified, statements in this manual apply to the 
Agilent 4100, 4200, and 4210 MP-AES instruments. 

Operation of an Agilent Microwave Plasma Atomic Emission 
Spectrometer (MP-AES) involves the use of compressed gases, high 
microwave energy and hazardous materials including corrosive fluids 
and flammable liquids. Careless, improper or unskilled use of this 
instrument can cause death or serious injury to personnel, and/or 
severe damage to equipment and property. Only trained personnel 
should use this equipment. 
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The MP-AES instrument incorporates interlocks and covers that are 
designed to prevent inadvertent contact with any potential hazards. 
If the MP-AES instrument is used in any manner not specified by 
Agilent, this protection may be impaired. It is good practice to 
develop safe working habits that do not depend upon the correct 
operation of the interlocks for safe operation. It is essential that no 
interlock or cover is bypassed, damaged or removed. 

The safety practices described below are provided to help the user 
operate the MP-AES instrument safely. Read each safety topic 
thoroughly before attempting to operate the MP-AES instrument and 
always operate the MP-AES instrument in accordance with these 
safety practices. 

If you are unsure of the effects of any liquid, gas or chemical on the 
MP-AES instrument, consult your Agilent field service engineer or 
approved representative before use. 

If the MP-AES instrument is to be used in conjunction with other 
non-Agilent equipment, the safety requirements of any system 
incorporating the MP-AES instrument is the responsibility of the 
assembler of the system. 

Verifying Safe State 
The following general safety precautions must be observed during all 
phases of operation, maintenance and service of this instrument.  

To ensure continued safety of the instrument after maintenance or 
service procedures verify the instrument is returned to a safe state 
before use. This includes running performance checks to verify the 
instruments safety systems are functioning correctly. Check the 
general condition of the instrument during operation for wear or 
signs of corrosion that are likely to inhibit function or safety. 

Failure to comply with these precautions or with specific warnings 
elsewhere in this manual violates safety standards of design, 
manufacture, and intended use of the instrument. Agilent 
Technologies assumes no liability for the customer’s failure to 
comply with these requirements. 
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Plasma 
The plasma is extremely hot (about 6,000 °C, 11,000 °F) and operates 
using high levels of microwave energy. The plasma emits high 
intensity light. Always wear appropriate eye protection if viewing the 
plasma. Close contact with the operating plasma can result in severe 
heat burns to the skin, and exposure to microwave radiation can 
cause sub-surface skin burns. 

Do not operate the plasma if:  

 the microwave excitation assembly appears to be damaged 

 foreign material is present in the viewing port (left end of the 
microwave excitation assembly) or the torch aperture (vertical 
space for the torch) 

 the space above the chimney is not clear of objects 

 the MP-AES instrument exhaust system is not connected or 
turned on 

The microwave excitation assembly is designed to reduce microwave 
radiation to safe levels while still permitting easy installation of the 
torch and viewing of the plasma. The MP-AES instrument has an 
interlock system that is designed to extinguish the plasma if either 
the pre-optics window holder is opened or the torch is unloaded 
before the plasma has been extinguished. Do not attempt to bypass 
the interlock system. 

Before opening the pre-optics window holder or unloading the torch, 
extinguish the plasma by: 

 pressing SHIFT and F5 on the keyboard 

 selecting the ‘Plasma off’ option from the ‘Plasma’ drop-down 
arrow on the MP Expert software toolbar  

 pressing the Plasma Enable switch on the front of the MP-AES 
instrument 

The torch remains hot for up to five minutes after the plasma is 
extinguished. Touching the torch before it has cooled sufficiently may 
result in burns. Allow the torch to cool before removing it from the 
loader. 



Safety Practices and Hazards 

10 Agilent Microwave Plasma Atomic Emission Spectrometers User’s Guide 

The plasma system has been carefully designed to operate safely and 
effectively when using torches and related components that conform 
to Agilent’s design criteria. Use of non-approved components in the 
MP-AES instrument may render the system inoperative and/or 
hazardous. It may also invalidate the warranty on the MP-AES 
instrument. Use only torches and related components supplied or 
authorized by Agilent. 

Heat, Vapors and Fumes 
Heat, ozone, vapors and fumes generated by the plasma can be 
hazardous, and must be extracted from the MP-AES instrument by 
means of an exhaust system. Ensure that an exhaust system of the 
appropriate type is fitted (as specified in the site preparation guide). 
The system must be vented to the outside in accordance with local 
regulations and never within the building. Regularly check the 
exhaust system by smoke test to ensure that the exhaust system is 
functioning correctly. The exhaust fan must always be switched on 
before igniting the plasma. 

Compressed Gas Hazards 
All compressed gases (other than air) can create a hazard if they leak 
into the atmosphere. Even small leaks in gas supply systems can be 
dangerous. Any leak (except that of air) can result in an oxygen-
deficient atmosphere which can cause asphyxiation. The storage area 
must be adequately ventilated and must comply with the rules and 
regulations imposed by the local authorities responsible for such use 
in the workplace. 

Gas cylinders must be stored and handled strictly in accordance with 
local safety codes and regulations. Cylinders must be used and stored 
only in a vertical position and secured to an immovable structure or 
a properly constructed cylinder stand. Move cylinders only by 
securing them to a properly constructed trolley. 

If gases are to be plumbed from a remote storage area to the 
instrument site, ensure that the local outlets are fitted with stop 
valves, pressure gauges and suitable regulators that are easily 
accessible to the instrument operator. The gas outlets must be 
provided within 1.5 meters (5 feet) of the MP-AES instrument. 
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Use only approved regulator and hose connectors (refer to the gas 
supplier’s instructions). Keep gas cylinders cool and properly 
labeled. (All cylinders are fitted with a pressure relief device that will 
rupture and empty the cylinder if the internal pressure is raised 
above the safe limit by excessive temperatures.) Ensure that you have 
the correct cylinder before connecting it to the MP-AES instrument. 

If using cryogenic (liquid) gases (for example, liquid nitrogen or 
argon) prevent severe burns by wearing suitable protective clothing 
and gloves. 

Dangerous Goods 
The Onboard Argon Bottle is considered dangerous goods when 
shipped and must comply with the rules and regulations imposed by 
the local and recipient’s authorities. 

Electrical Hazards 
The MP-AES instrument and some accessories contain electrical 
circuits, devices and components operating at dangerous voltages. 
Contact with these circuits, devices and components can cause death, 
serious injury or painful electric shock. Panels or covers that are 
retained by screws on the MP-AES instrument and accessories may 
be opened only by Agilent­trained, Agilent-qualified or 
Agilent­approved field service engineers (unless specifically 
instructed). Consult the documentation or product labels supplied 
with your personal computer (PC), monitor and printer to determine 
which parts are operator-accessible.  

The power cord set shipped with the MP-AES instrument cannot be 
used with other products. 

If necessary, replace the power cord only with a cord equivalent to 
the one specified in the site preparation guide. 
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Other Precautions 
Use of the MP-AES instrument and accessories may involve 
materials, solvents and solutions that are flammable, corrosive, toxic 
or otherwise hazardous. Careless, improper or unskilled use of such 
materials, solvents and solutions can create explosion hazards, fire 
hazards, toxicity and other hazards that can result in death, serious 
personal injury or damage to equipment. 

Always ensure that laboratory safety practices governing the use, 
handling and disposal of hazardous materials are strictly observed. 
These safety practices should include wearing appropriate safety 
clothing and safety glasses. 

Air flow to the MP-AES instrument and accessories must be 
unobstructed. Do not block the ventilation grill on the instrument. 
Allow at least 50 mm (2 in.) of space on the sides, and 150 mm (6 in.) 
at the rear of the system to permit free air circulation. Consult the 
documentation supplied with your PC, monitor and printer for their 
specific ventilation requirements. 

Great care should be taken when working with glass or quartz parts 
to prevent breakage and cuts. This is especially important when 
attaching plastic tubing to glass barbs, or removing and replacing 
pieces of broken torch. 

The MP-AES instrument weighs approximately 73 kg (161 lb). To 
avoid injury or damage to the MP-AES instrument or property, 
always use a forklift or other suitable mechanical lifting device to 
move the MP-AES instrument. 

Use only Agilent-supplied spares with your MP-AES instrument. 

Warning Symbols 
The following is a list of symbols that appear in conjunction with 
warnings in this guide and on the MP-AES instrument. The hazard 
they describe is also shown. The beginning of the warning text is 
noted by a warning icon: 

WARNING 
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A triangular symbol indicates a warning. The meanings of the 
symbols that may appear alongside warnings in the documentation 
or on the MP-AES instrument itself are as follows: 

 

 
Corrosive liquids 

 
Electrical shock 

 
Extreme cold 

  
Eye hazard 

  
Fire hazard 

  
Heavy weight 

(danger to feet) 

  
Heavy weight 

(danger to hands) 

  
Hot surface 

  
Moving parts 

  
Non-ionizing radiation 

  
Noxious gases 

  
Sharp object  

The following symbol may be used on warning labels attached to the 
MP-AES instrument. When you see this symbol, refer to the relevant 
operation or service documentation for the correct procedure 
referred to by that warning label. 
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The following symbols appear on the MP-AES instrument. 

I Mains power on 

0 Mains power off 

 Single phase alternating current 

 Socket for Agilent accessory USB cable 

Color Coding 
The various indicator lights appearing on Agilent instruments and 
associated accessories represent the status of the instrument or 
accessory.  

 A green light indicates the instrument is in normal/standby 
mode. 

 A flashing green light indicates that firmware is being uploaded 
from the PC to the MP-AES instrument or that there is no USB 
connection from the PC to the MP-AES instrument. 

CE Compliance 
Your MP-AES instrument has been designed to comply with the 
requirements of the Electromagnetic Compatibility (EMC) Directive 
and the Machinery Directive of the European Union. Agilent has 
confirmed that each product complies with the relevant Directives by 
testing a prototype against the prescribed EN (European Norm) 
standards. 

Proof that a product complies with these directives is indicated by: 

 the CE Marking appearing on the rear of the product, and 

 the documentation package that accompanies the product 
containing a copy of the Declaration of Conformity. The 
Declaration of Conformity is the legal declaration by Agilent that 
the product complies with the directives listed above, and shows 
the EN standards to which the product was tested to 
demonstrate compliance.  
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Electromagnetic Compatibility 

EN55011/CISPR11 
Group 1 ISM equipment: group 1 contains all ISM equipment in 
which there is intentionally generated and/or used conductively 
coupled radio- frequency energy which is necessary for the internal 
functioning of the equipment itself. 

Class A equipment is equipment suitable for use in all 
establishments other than domestic and those directly connected to a 
low voltage power supply network which supplies buildings used for 
domestic purposes. 

This device complies with the requirements of CISPR11, Group 1, 
Class A as radiation professional equipment. Therefore, there may be 
potential difficulties in ensuring electromagnetic compatibility in 
other environments, due to conducted as well as radiated 
disturbances. 

Operation is subject to the following two conditions: 

1 This device may not cause harmful interference. 

2 This device must accept any interference received, including 
interference that may cause undesired operation. 

If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try one or more of 
the following measures: 

1 Relocate the radio or antenna. 

2 Move the device away from the radio or television. 

3 Plug the device into a different electrical outlet, so that the device 
and the radio or television are on separate electrical circuits. 

4 Make sure that all peripheral devices are also certified. 

5 Make sure that appropriate cables are used to connect the device 
to peripheral equipment. 

6 Consult your equipment dealer, Agilent Technologies, or an 
experienced technician for assistance. 
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Changes or modifications not expressly approved by Agilent 
Technologies could void the user’s authority to operate the 
equipment. 

South Korean Class A EMC declaration 
This equipment is Class A suitable for professional use and is for use 
in electromagnetic environments outside of the home. 

A급 기기 

(업무용 방송통신기자재) 

이 기기는 업무용(A급) 전자파적합기기로서 판 

매자 또는 사용자는 이 점을 주의하시기 바라 

며, 가정외의 지역에서 사용하는 것을 목적으 

로 합니다. 

ICES/NMB-001 
This ISM device complies with Canadian ICES- 001. 

Cet appareil ISM est conforme à la norme NMB-001 du Canada. 
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Site Preparation Requirements 
Prior to receiving your Agilent MP-AES instrument, you will have 
been provided with an Agilent MP-AES Site Preparation Guide, 
which describes the environmental and operating requirements and 
specifications of the MP-AES instrument. You must prepare your 
laboratory according to these instructions and specifications before 
the instrument can be installed. You should keep the site preparation 
guide for future reference. If you have misplaced your copy, you can 
obtain a replacement from your local Agilent office. 

User Documentation 
You have been provided with the following documentation to help 
you set up and operate your MP-AES instrument: 

 The Agilent MP-AES Site Preparation Guide, with information on 
how to set up your laboratory in preparation for the MP-AES 
instrument. 

 This User’s Guide, with safety practices and hazards information, 
instructions for finding information about installing and 
maintaining the components of the MP-AES instrument and a 
brief operation overview. 
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 An extensive Help system containing context-sensitive Help, step-
by-step instructions for frequently performed operations and 
instructions for using any accessories you ordered. Access the 
Help by pressing F1 on your keyboard with the MP Expert 
software open, by clicking the resources icon and then Help and 
Documentation on the Start page, or by double-clicking the MP 
Expert Help icon on the computer desktop. 

Conventions 
The following conventions have been used throughout the 
documentation: 

 Menu items, menu options and field names (for example, click 
Copy on the Edit menu) have been typed in bold. Bold is also 
used to signify the pushbuttons appearing throughout the 
software (for example, click OK). 

 ALL CAPITALS indicate keyboard and mouse commands (for 
example, press the F2 key) and text you must type using the 
keyboard (for example, type SETUP at the prompt). 

Notes and tips 
A Note is used to give advice or information. 

A Tip is used to give practical hints to help you achieve the best 
possible performance from your MP-AES instrument. 

Specifications 
Installation category 
The installation category is based on IEC61010:II. The installation 
category implies the regulation for impulse withstand voltage. It is 
also called the ‘Over voltage category’. ‘II’ applies to electrical 
equipment. 

Pollution level 
The pollution level is based on IEC61010:2. Pollution level describes 
the degree to which a solid, liquid or gas that deteriorates dielectric 
strength is adhering. ‘2’ applies to a normal indoor atmosphere. 
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Environmental conditions 
See the Agilent MP-AES Site Preparation Guide for specifications. 

Laboratory conditions 

The area selected for the operation of an MP-AES instrument: 

 must be free from drafts, corrosive atmospheres and vibration 

 should have sample preparation areas and materials storage 
facilities located in a separate room 

 must be a dust-free, low humidity environment 

 should have air conditioning for control of the environment 

Temperature control 

Most of the heat generated by the MP-AES instrument into the 
laboratory is extracted from the laboratory by the exhaust system. 
When the plasma is operating, approximately 200 W of heat from the 
MP-AES instrument electronics flows into the laboratory. 

Electrical power supplies 
All power supplies should be single phase AC, 3 wire system (active, 
neutral, ground or two active and ground) and should be terminated 
at an appropriate connection receptacle that is within reach of the 
system power cable. Use of power boards or extension cables is not 
recommended. 

Electrical requirements 

The installation of electrical power supplies must comply with the 
rules and/or regulations imposed by the local authorities responsible 
for the use of electrical energy in the workplace. 

Avoid using power supplies from a source that may be subject to 
electrical interference from other services (such as large electric 
motors, elevators, welders and air conditioning units). 
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Other electrical connections 

USB 

NOTE Basic insulation is provided for single fault protection on the USB connector. 

Gas supplies 
The primary gas used by the MP-AES instrument is nitrogen, which is 
the supply gas for the plasma. A small quantity of argon is used in 
the plasma ignition cycle. Oil-free compressed air is used for the 
pre-optics protection gas. Other gases may be required for future 
options and accessories. Use only ‘instrument-grade’ nitrogen with 
your MP-AES instrument. 

The installation of compressed or liquid gas supplies must comply 
with the rules and/or regulations imposed by the local authorities 
responsible for such use in the workplace. 

See the Agilent MP-AES Site Preparation Guide for gas pressure 
requirements. 

Liquid or gaseous argon and nitrogen may be used with the MP-AES 
instrument. Agilent recommends the use of liquid gases, which are 
more pure, more convenient and cheaper per unit volume.  

The main gas supply requirements used with the MP-AES instrument 
are: 

 Nitrogen — for the plasma and nebulizer gas supply 

 Air — for the pre-optics protection gas 

 Argon — only required during plasma ignition 

Additional gas supply requirements used when the optional External 
Gas Control Module (EGCM) or Monochromator Air Purge 
accessories are installed are: 

 Purge gas: nitrogen — for optics purging when analyzing elements 
below 185 nm, or air — for optics purging in corrosive 
environments 
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 Air — for supply of air to the plasma when analyzing organic 
samples 

The MP-AES instrument is fitted with PTFE gas supply hose 
assemblies, 1.8 meters (6 feet) in length, and 1/4 inch Swagelok 
hardware.  

The operator (or other authorized personnel) must carry out 
appropriate leak tests necessary to ensure safety on the gas 
connections that the operator is directed to assemble during 
installation, normal use or maintenance. 

To avoid an unacceptable pressure drop in the tubing, the nitrogen 
and argon supplies from the regulator to the instrument should be 
not less than 3 mm internal diameter and not more than 10 m length. 
This will give a pressure drop of approximately 50 kPa in the tubing. 

 

CAUTION Use only the tubing supplied with the instrument (or equivalent quality) to deliver 
argon to the instrument. Inferior plastic or rubber tubing may cause ignition 
problems due to contamination of the argon by atmospheric gases. 

Exhaust system 
The plasma operates at extremely high temperatures. The MP-AES 
instrument exhaust fumes can be noxious or corrosive. 

The MP-AES instrument exhaust must be directly connected to an 
exhaust system. The exhaust system must include an exhaust fan, be 
ducted to an external vent and provide a minimum flow of 3 m3/min 
(106 ft3/min).  

The exhaust system installation must comply with any rules and/or 
regulations that may be imposed by the local authorities responsible 
for control of facilities and fixtures in the workplace. 

The exhaust fan should be located at least 2 meters (6 ft, 6 in) away 
from the top of the MP-AES instrument chimney. The fan control 
switch and running indicator lamp should be located in a position 
where the instrument operator can view the indicator and access the 
control switch. 
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WARNING 

 
 

Hot Surface 
The external vent may become hot during MP-AES instrument operation and 
remain hot for some time after the MP-AES instrument has been switched off. 
Allow the external vent to cool for at least five minutes before attempting to 
remove the exhaust hose. Use heat-resistant gloves. 

MP-AES instrument cooling air supply 
The MP-AES instrument requires clean, dry, non-corrosive air for 
cooling purposes. This is supplied to the MP-AES instrument through 
an air supply vent located at the top, rear of the instrument. The vent 
has a dust filter, to filter out particulate matter. 

The air supply is used to cool the internal mechanical and electronic 
components of the MP-AES instrument. Several of these assemblies 
contain parts prone to corrosion. The introduction of cooling air 
contaminated with high levels of acid vapors or other corrosive 
substances may cause damage to the MP-AES instrument. 

Due to the corrosive nature of some analytical work, it is 
recommended that in applications demanding high usage of corrosive 
materials, an external cooling air supply system is provided. It is 
required that the cooling air be supplied from an environmentally-
controlled area that is away from the MP-AES instrument exhaust 
and any other area where corrosive materials are stored or used. Do 
not duct humid, warm air into an MP-AES instrument in a cooled 
laboratory environment. 

The cooling air system with flue, fan, ducting and supply cowl, must 
provide a minimum positive flow of 3 m3/min (106 ft3/min). The 
ducting should be corrosion-resistant and fire-proof. 

Drain vessel 
The MP-AES instrument needs a drain vessel for disposal of excess 
fluids and vapors from the spray chamber. Suitable tubing is 
supplied with the MP-AES instrument for use with inorganic 
solvents. When using organic solvents, different drain tubing that is 
suitable for the solvent in use will be required. 
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A chemically-inert container, not glass, to hold a minimum of 2 liters 
(4 pints) of waste must be provided by the user. It should be located 
underneath the sample tray (or on the right side of the MP-AES 
instrument), where it is protected by the bench and in full view of the 
operator. 

Disposal of all chemical waste must comply with any rules and/or 
regulations that may be imposed by the local authorities. 

Personal computer requirements 
The recommended and minimum PC specifications can be found in 
the Agilent MP-AES Site Preparation Guide.  

Locate the PC keyboard and mouse for ergonomically correct access. 

Weights and dimensions 
For the weights and dimensions of your MP-AES instrument please 
see the Agilent MP-AES Site Preparation Guide. 

 

WARNING 

 
 

Heavy Weight 
Danger to feet and hands. The Agilent MP-AES instrument weighs 
approximately 73 kg (161 lb). To avoid injury to personnel or damage to 
equipment, always use a fork lift or other suitable lifting device when moving 
the MP-AES instrument. 

 

Position the MP-AES instrument on the bench to allow easy access to 
the power switch located on the right side of the instrument. 
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The Agilent MP-AES instrument must be installed by an Agilent-
trained, Agilent-qualified or Agilent-authorized field service engineer. 

You should have completed and returned the form in the Agilent 
MP-AES Site Preparation Guide stating that you have prepared the 
laboratory in accordance with the requirements detailed in that 
guide.  

Details for unpacking the MP-AES instrument and what to do in case 
it has been damaged in transit are also outlined in the site 
preparation guide. 
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Agilent MP-AES Instrument Overview 

 

Figure 1. Front of the MP-AES instrument 

Where: 

1. Power status LED 5. Peristaltic pump 9. Torch 

2. Plasma Enable button/ 
status LED 

6. Pre-optics window 
access door 

10. Torch clamp for spray 
chamber and torch 

3. Optional AVS 4 Switching 
Valve accessory  

7. Plasma viewing port 11. Spray chamber 

4. Nebulizer gas supply 8. Torch loader handle 12. Nebulizer 

 

NOTE If the Plasma Enable button is used to extinguish the plasma, you will need to 
reset the Plasma Enable button to the ‘Enable’ (pushed in) position before the 
plasma can be re-ignited. 
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All connections of services to the MP-AES instrument are made on 
the right side of the instrument. Remove the cover by hand to gain 
access to the power, USB, accessory, and gas connections. The 
onboard argon bottle and regulator (if used) are also accessed via 
this side cover. 
 

 

Figure 2. Input and output connections on the side of the MP-AES instrument 

 Item Description 

1 Accessory port DA-15 receptacle 
For connection of Agilent-specified accessories only 

2 Sampler port DE-9 plug. RS-232 port for connection of the Agilent SPS 3 
autosampler 

3 Power switch Combination power switch and main circuit breaker (12 A) for 
the MP-AES instrument 

4 Power inlet IEC-C14 mains power inlet receptacle 
Accepts IEC-C13 mains lead 

5 USB port USB type B receptacle. Supports USB 2.0 Full Speed 
Length of USB cable to PC is to be a maximum of 3 m (10 ft) 

6 Gas inlets Connect required gas supplies 
7 Onboard argon 

bottle receptacle 
Onboard argon bottle location 
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4 
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2 

6 
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Installing the MP Expert Software 
Although the Agilent-trained, Agilent-qualified or Agilent-authorized 
field service engineer will install the MP Expert software for you 
during the installation process, you may need to install the software 
yourself at some later stage, for example if you change the PC.  

NOTE Install the MP Expert Software first, and then plug the USB cable into the 
computer. 

To install the MP Expert software: 

1 Log on to the instrument computer with Administrative rights. 

2 Insert the MP Expert Software disk in your CD-ROM drive. The 
software will automatically start1. 

3 Follow the instructions on the screen. 

4 Click Yes to restart the computer if prompted. 

5 Plug the USB cable into the USB port on the MP-AES instrument 
and then into a USB port on the computer. 

6 Once installation is complete, you will need to register your 
MP Expert Software. To start the MP Expert software, double-
click the MP Expert icon on your computer desktop. Complete 
the Software Registration, if requested to do so, referring to the 
Help if required. 

TIP To familiarize yourself with the MP Expert software, after installation, double-
click the MP Expert icon on your computer desktop. When the MP Expert Help 
appears, click the How to link to view step-by-step instructions on how to use 
the MP-AES instrument. 

 

                                                           
1 If you have turned off the auto-start capability of your CD-ROM drive, you will need to run the MPExpertSetup.exe file on 
the disk. 
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Hardware Components Replacement 
Your MP-AES instrument should be ready to operate after the Agilent 
field service engineer has installed it. However, during use you may 
need to set up items such as the pre-optics window, torch, spray 
chamber, nebulizer or peristaltic pump tubing.  

To find instructions on how to replace these items, double-click the 
MP Expert Help icon on your computer desktop (or, with the MP 
Expert software open, press F1 on your keyboard). Expand the ‘How 
To’ section and then select the appropriate topic. 

NOTE Torches used with Agilent 4100 MP-AES instruments are different from the 
torches used with the Agilent 4200 and 4210 MP-AES instruments and are not 
interchangeable. Torches for the 4100 MP-AES have a grey base (Figure 3). 
Torches for the 4200 and 4210 MP-AES have a blue base (Figure 4). 

 

 
Figure 3. 4100 MP-AES EasyFit torch 

 
Figure 4. 4200 and 4210 MP-AES EasyFit 
torch 
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Accessories 
The following accessories may be available for use with your MP-AES 
instrument: 

 Organic solvents kit 

 External Gas Control Module (EGCM) 

 SPS 3 and SPS 4 Autosamplers 

 Advanced Valve System (AVS) 4 

 SVS 1/1+ Switching Valve System 

 SVS 2 Switching Valve System 

 Agilent 4107 Nitrogen Generator 

 Multimode sample introduction system (MSIS) 

 Monochromator air purge 

For installation information, please see the accessory documentation 
provided with the accessory or the MP Expert Help. 

NOTE You must turn off the MP-AES instrument when accessories are plugged into or 
unplugged from the Accessory Port. 

Organic solvents kit 
For safety information and to install the kit on the MP-AES 
instrument, please see the instructions that came with the 
application kit. 

If organic solvents are used, special organic resistant pump tubing is 
highly recommended. 
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External Gas Control Module (EGCM) 
For safety information and to install the EGCM on the MP-AES 
instrument, please see the instructions that came with the accessory. 

The EGCM is an accessory with two specific functions: 

 Supply nitrogen gas to purge the optics system for analytical 
measurements below 185 nm 

 Introduce a small amount of air into the plasma for the analysis 
of organics. The air facilitates the analysis of organics by MP-AES 
instrument techniques by reducing carbon buildup and 
background signal resulting in lower detection limits when 
analyzing organic solutions. 

SPS 3 and SPS 4 Autosampler 
For safety information and to prepare the SPS 3 or SPS 4 for 
installation, please see the instructions that came with the accessory. 

The SPS 3 and SPS 4 are compatible with a wide range of 
commercially available low-cost autoclavable sample racks.  

Sample contamination from airborne particles is eliminated and 
corrosive or toxic fumes are removed during sampling with the 
optional environmental enclosure. 

Advanced Valve System (AVS) 4 
For safety information and to prepare the accessory for installation, 
please see the instructions supplied with the accessory. 

The integrated AVS 4 (4 port switching valve) rinses the sample 
introduction system while the next sample is being readied for 
analysis prior to measurement. Excess sample is diverted away from 
the spray chamber and rinse is introduced immediately after 
measurement. This will increase productivity, reduce sample carry-
over and required cleaning frequency of sample introduction 
components. 
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SVS 1/1+ 
For safety information and to prepare the SVS 1 or SVS 1+ for 
installation, please see the instructions that came with the accessory. 

The SVS 1/1+ is a 4-port switching valve positioned between the 
spray chamber and the peristaltic pump of the spectrometer. During 
the rinse time, when the instrument is usually idle, the autosampler 
cleans the probe and presents the next sample for measurement, 
increasing productivity. Excess sample is diverted away from the 
spray chamber immediately after measurement, reducing sample 
carry-over. 

SVS 2 
For safety information and to prepare the SVS 2 for installation, 
please see the instructions that came with the accessory. 

The SVS 2 increases sample throughput and decreases turnaround 
time and operating costs. The SVS 2 features triple-stacked, 4-port 
switching valve positioned between the spray chamber and the 
peristaltic pump of the spectrometer. Samples are quickly loaded 
into the SVS 2 sample loop, ready for immediate analysis by the 
MP-AES, greatly reducing sample uptake delays. Pre-emptive rinsing 
of the sample line means analysis times are reduced. The SVS 2 also 
features an internal T-piece within the valve, reducing dead volume 
and providing online addition of internal standard and ionization 
buffer solutions. A bubble injector automatically injects bubbles after 
the sample is loaded into the loop, isolating the sample from the rinse 
solution. This reduces the volume of sample required for 
measurement as tailing (or dilution) effects are minimized. 

Agilent 4107 Nitrogen Generator  
For safety information and to prepare the nitrogen generator for 
installation, please see the User’s Guide that came with this 
accessory. 
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The Agilent 4107 Nitrogen Generator can be used to provide a 
nitrogen supply for the MP-AES instrument and EGCM. This allows 
the instrument to operate without the need for a cylinder or Dewar 
nitrogen supply. A supply of clean, dry, oil-free compressed air is 
required to supply the nitrogen generator and the MP-AES 
instrument. This can be supplied from an in-house supply (if it meets 
the flow and purity requirements) or a commercial air compressor. 
For details on the required air flow and purity requirements for the 
nitrogen generator, please see the Agilent MP-AES Site Preparation 
Guide. 

NOTE Separate nitrogen generator units must be used to supply the nitrogen to the 
MP-AES instrument and the ECGM. 

Multimode sample introduction system (MSIS) 
For safety information and to prepare the MSIS for installation, 
please see the instructions that came with this accessory and the MP 
Expert Help. 

The MSIS is used with the MP-AES instrument to provide 
simultaneous vapor generation of several hydride forming elements, 
enabling determination with low ppb detection limits. 

The MSIS consists of the OneNeb nebulizer and modified glass 
cyclonic spray chamber that has two vertical conical tubes in the 
center of the chamber. This allows for reductant and sample to mix 
quickly and thoroughly in the chamber using thin film hydride 
technology to form the hydrides. 

The MSIS can be operated in three modes: hydride only, 
simultaneous hydride and conventional nebulization or conventional 
nebulization only.  
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Monochromator air purge 
For safety information and to prepare the monochromator air purge 
accessory for installation, please see the instructions that came with 
this accessory and the MP Expert Help. 

The monochromator air purge accessory provides clean air to the 
MP-AES instrument monochromator to maintain it at a positive 
pressure. This should be used to prevent the ingress of dust and 
corrosive vapors from the laboratory environment.  
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This chapter provides a quick guide to getting the Agilent MP-AES 
instrument set up and running samples. 

You will find step-by-step instructions for common operations in the 
MP Expert Help. To access this information: 

1 Double-click the MP Expert Help icon on the computer desktop. 

2 When the MP Expert Help appears, click How to to view the 
available step-by-step instructions. 

Analysis Checklist 
You need to complete the following steps in turn to measure a 
solution. You will find information on each step in this chapter. 

 Turn on the MP-AES instrument and open the software 

 Prepare for analysis 

 Perform a wavelength calibration of the MP-AES instrument 

 Create/open a worksheet 

 Develop a method 
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 Run samples 

 Print a report 

Turning On the MP-AES Instrument and Software 
Before starting the system, carefully read the Safety Practices and 
Hazards section at the front of this guide and ensure that the 
laboratory is set up according to the details specified in the Agilent 
MP-AES Site Preparation Guide. 

To turn on the MP-AES instrument and start the software: 

1 Check that the exhaust and intake lines are secured to the 
MP-AES instrument. 

2 Ensure the gas lines are connected to the MP-AES instrument 
and that the gas supplies are turned on and set to the correct 
pressures. 

3 Check that the USB and power cables are plugged in. 

4 Check that the pre-optics window is clean and correctly installed 
and that the interlock is engaged. 

5 Check that the torch is clean and in good condition. 

6 Insert the torch and completely close the torch handle. Fit the 
spray chamber socket to the ball joint on the base of the torch 
and secure using the torch clamp. 

7 Check that all tubing on the spray chamber, nebulizer and 
peristaltic pump are correctly connected. 

8 Switch on the computer, monitor and printer. 

9 Switch on the laboratory exhaust system.  

10 Turn on the MP-AES instrument.  

11 Ensure that the Plasma Enable Switch is in the Enable state 
(pushed in). 
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WARNING 

 
 

Hot Surfaces – Noxious Fumes – Non-Ionizing Radiation 
Burn danger, inhalation hazard. The plasma emits heat, ozone and fumes, 
which can be hazardous. Always switch on the exhaust system before 
lighting the plasma. 

 
12 To start the MP Expert software, double-click the MP Expert 

desktop icon. The ‘Main Index’ window will appear. 

Preparing for Analysis 
To prepare for analysis: 

1 Click the Plasma button in the MP Expert software. Alternatively, 
press F5 or choose Plasma on from the arrow under the Plasma 
button.  

2 Ensure that the peristaltic pump is correctly set up (refer to the 
Peristaltic Pump section of the Help). If you have not already 
done so, adjust the pressure bars on the peristaltic pump for 
even sample flow. 

3 Place the sample tubing from the peristaltic pump into the rinse 
solution and the drain tubing into the drainage vessel. 

4 Click the Pump button in the MP Expert software and choose 
Normal (15 rpm) from the arrow under the Pump button. The 
pump will be initialized and the solution will begin aspirating.  
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NOTE See the MP Expert Help for instructions on how to adjust the peristaltic pump 
pressure bars. 

NOTE For optimum performance and stability, for the MP-AES instrument a warm up 
time of 30 minutes is recommended, from standby. 

NOTE When using the nitrogen generator, a purge time of up to 20 minutes is required 
from power on, depending on the prior usage history, to allow the nitrogen 
generator to achieve required nitrogen purity. 

NOTE The plasma will take between 10–15 seconds to ignite. If it fails to ignite, refer to 
the Troubleshooting section in the Help for further information. In addition, the 
plasma can be run dry (no solution) without damaging the torch. 

CAUTION The plasma cannot be run without the spray chamber and nebulizer gas supply 
connected. Doing so will damage the torch. 

MP-AES Instrument Wavelength Calibration  
Refer to the Help for information about what a wavelength 
calibration is, and how to prepare the wavelength calibration 
solution.  

To perform an MP-AES instrument wavelength calibration: 

1 If you are using a 4100 MP-AES, ensure a standard glass 
concentric nebulizer, a single pass spray chamber and 4100 
EasyFit plasma torch are installed. If you are using a 4200 or 
4210 MP-AES, ensure the OneNeb nebulizer, double pass spray 
chamber and 4200 and 4210 EasyFit torch are installed. Use 
manual sampling for both models. 
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NOTE You must install the correct peristaltic pump tubing for the wavelength 
calibration: 

 Pump Drain 
4100 MP-AES White/white Blue/blue 
4200 and 4210 MP-AES Orange/green Blue/blue 

 
 

 

2 Click the Instrument button. 

3 Click Calibration. 

4 Place the solution inlet tubing into the wavelength calibration 
solution and allow the sample to reach the plasma. 

5 Click Calibrate Instrument. The torch will be aligned and then a 
wavelength calibration and a calibration check will be performed 
automatically. 

6 After a short while, an indication of the success or failure of the 
calibration check will appear, as well as an indication of the 
wavelength offsets. 

7 If the calibration fails, check the sample introduction system. If 
the system seems fine, prepare a new wavelength calibration 
solution and try again, or consult the Troubleshooting section of 
the MP Expert Help. 

Creating/Opening a Worksheet 

Creating a new worksheet 
To create a new worksheet, click New from the Start page or the File 
menu.  

A list of recently used files will be presented when creating a new 
worksheet from a template; otherwise you may Browse for more files. 
The ‘New From Template’ dialog box will be displayed in this 
instance. 
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Opening an existing worksheet 
To open an existing worksheet: 

1 Click Open from the Start page or from the File menu.  

2 A list of recently used files will be displayed. Otherwise, you may 
Browse for more files. The ‘Open’ dialog box will be displayed in 
this instance. 

NOTE If you attempt to open a worksheet that is setup for use with a model other than 
the one currently connected, you will be prompted as to whether or not you 
would like the worksheet to be converted or that it will be opened as a Read-
only file. Converting the worksheet will ensure that all settings are compatible 
with the connected instrument. Any changes that have been made will be 
visible in the Operation Log of the worksheet. 

It is recommended that the conditions are re-optimized after a conversion has 
taken place. 

Creating a new worksheet from a template 
To create a new worksheet from a template click New From on the 
Start page or New From Template from the File menu.  

A list of recently used files will be presented, otherwise you may 
Browse for more files. The ‘New From Template’ dialog box will be 
displayed in this instance. 

The Worksheet window will appear with the new worksheet loaded. 

Developing a Method 
To develop a method: 

1 Open a new worksheet or one from a template. 

2 On the ‘Elements’ page, select the element(s) from the ‘Element’ 
drop-down box or type the element name or symbol and then 
perform one of the following:  

a Click  to add the primary wavelength for the selected 
element.  
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b Highlight the wavelength you wish to use from the list of 
available wavelengths displayed. Click Add.  

NOTE Alternatively, press CTRL and the element from the periodic table to add the 
primary wavelength for the selected element to your method. 

The element will appear in the table with the selected wavelength 
and default settings selected. 

3 Check that there are no interferents or other analytical lines 
close to the selected analytical line. Their relative intensity will 
govern how close the lines can be to each other. For example, if 
your matrix contains an element that is not of analytical interest, 
but is a potential interferent and has a line close to one of your 
analytical lines, the concentration of that element in your matrix 
will determine whether you need to choose another analytical 
line.  

4 Make any required adjustments to each element including 
selecting a different wavelength, entering additional information 
into the ‘Label’ column, selecting the type of sample (choose from 
analyte, internal standard or interferent) and the type of 
background correction is to be used.  

5 Enable QC and/or IEC in the Configuration tab if these features 
are going to be used. (Available only on the full version of the MP 
Expert software.)  

6 Click Conditions to modify both common settings for the run and 
settings for each element. Nebulizer gas settings and viewing 
positions can now be optimized. 

NOTE The software can automatically determine and set the optimal operating 
conditions for each element. For detailed information on how to select the 
conditions, see the MP Expert Help > Software > Worksheet Page > Conditions. 

7 Click QC (if enabled) to enter the method detection limits, select 
the QC tests to be used and which error actions should be 
performed if an error occurs. 
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8 Click Standards to enter the concentration of the elements in 
your standards and select whether to use other options such as 
Standard Additions or MultiCal. 

9 Click IEC (if enabled) to enter the concentration of the elements 
in your IEC standards. 

10 Click Sequence to specify the end of run actions, number of 
samples, select the solution type and edit the sample labels. 

11 If you are using an autosampler, click the ‘Autosampler’ tab to 
select the racks and probe depth (if needed). Depending on the 
autosampler selected, options may vary. 

NOTE See the MP Expert Help for a more detailed description of setting up a method. 

Running Samples 
To run samples: 

1 Click the Analysis tab and do the following: 

a Ensure your samples are selected. This will be indicated by a 
check next to the Rack:Tube column. To select all solutions, 
select the checkbox next to the Rack:Tube title. 

 

 
b Click the Run icon in the toolbar (or press the SHIFT+F8 

keys) to begin the analysis, and follow the subsequent 
prompts. 

NOTE For further information about running an analysis, refer to the MP Expert Help. 
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Printing a Report 
To print a report: 

1 Click Report on the toolbar or File > Report. 

2 Choose whether you want to print or preview the report or save 
the report as a PDF file. 

TIP Previewing the report allows you to ensure that you have included all of the 
data you require. 

3 Select the report template and then click Open. 

4 Click the Print button to generate a report as specified. A 
message will appear briefly indicating the progress status of the 
report being generated. 

5 The Print dialog box will then be opened. You can select to print 
all of the report, or a range of pages. Reports are printed to your 
default printer, unless you specify otherwise. You can specify 
your printer options in the Print Setup dialog box, accessible 
from the File menu. 

As the Print dialog box is a standard Windows dialog box, you can 
obtain ‘What’s this’ help on an item by clicking the question mark 
icon in the top right corner and then clicking the item of interest. 

Turning Off the MP-AES instrument 
To turn off the MP-AES instrument: 

1 Rinse the spray chamber by aspirating water (or the appropriate 
solvent for your application) for a few minutes. 

NOTE When running organic samples it is recommended that the spray chamber be 
cleaned and dried thoroughly between analyses. 

2 Remove solution tubing from the solution. Using the peristaltic 
pump, pump all solution from the sample line, nebulizer and 
spray chamber and then continue to run for another 30 seconds 
to ensure that the sample introduction system is solution free. 
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3 Extinguish the plasma by choosing Plasma Off from the Plasma 
button drop-down arrow or pressing SHIFT and F5 on the 
keyboard. The peristaltic pump stops automatically when the 
plasma is extinguished. 

NOTE The green Plasma enable button, located on the front of the MP-AES 
instrument, is intended to be used only in an emergency. It is not intended to be 
used every time you want to extinguish the plasma. If it is used to extinguish 
the plasma, you will need to reset the Plasma enable button to the ‘on’ position 
before the plasma can be re-ignited. 

4 The mains power switch can be left on. 

5 To increase the pump tubing lifetime, loosen the pressure on the 
peristaltic pump tubing by releasing the pressure bars and lifting 
the tubing out of the grooves in the tube retainer. To do this: 

a Push up the pressure bar tensioners. (1 in Figure 5). This 
releases them from the pressure bar.  

b Allow the pressure bar to swing backwards. (2 in Figure 5) 

c Lift the tubing out of the grooves in the tube retainer. (3 in 
Figure 5) 

 

Figure 5. Peristaltic pump components 

If you would like immediate operation next time the MP-AES 
instrument is started, leave the PC and gas on. Close the worksheet 
by choosing Close from the File menu but leave the MP Expert 
software running. You may switch off the printer, monitor and any 
accessories.  

It is recommended that the power save option on your PC is disabled. 
 

1 

2 
3 
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WARNING 

 
 

Noxious Fumes 
Asphyxiation danger. The exhaust system MUST remain on if the gas supplies 
are on. 

NOTE If the MP-AES instrument is not going to be in use for a period of time the torch 
should be cleaned of any deposits, dirt or residue. For further information about 
cleaning the torch see Page 49. 
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This chapter includes the Agilent MP-AES instrument maintenance 
requirements that may be carried out by an operator. Any 
maintenance procedures not specifically mentioned in this chapter 
should be carried out only by Agilent-trained, Agilent-qualified or 
Agilent-authorized field service engineers. 

 

WARNING 

 

Shock Hazard 
The MP-AES instrument contains electrical circuits, devices and 
components operating at dangerous voltages. Contact with these circuits, 
devices and components can result in death, cause serious injury, or painful 
electrical shock. 

NOTE This section refers to maintenance procedures for the MP-AES instrument. You 
should refer to your PC and printer documentation for their maintenance 
procedures, and to the MP Expert Help for the maintenance procedures for any 
accessories you ordered. 
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Routine Maintenance 
The following parts of the MP-AES instrument require routine 
maintenance.  

Daily  

 Check and, if necessary, empty the drain vessel. 

 Inspect the torch condition and cleanliness. Clean as necessary. 
See Page 49. 

 Clean the surface of your MP-AES instrument (spills should be 
cleaned up immediately). 

 Inspect the pump tubing and replace if it has lost its elasticity. 
Unclip the pump tubes when the pump is not in use. 

Weekly 

 Inspect the spray chamber for cleanliness. Clean as necessary. 
See Page 50. 

 Clean the nebulizer. 

 Inspect the pre-optics window for cleanliness. Clean or replace 
as necessary. 

Monthly 

 Clean the air inlet filter on top of your MP-AES instrument. 

 Perform an MP-AES instrument calibration. 

 Inspect the external gas supply system for leaks including the 
tubing connected to the MP-AES instrument. Replace any 
damaged, leaking or worn components. 

To find instructions on how to perform maintenance procedures 
double-click the MP Expert Help desktop icon or, with the MP Expert 
software open, press F1 on your keyboard. Expand the ‘Maintenance’ 
section and then select the appropriate topic. 
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Cleaning the MP-AES Instrument 
Any spills in the sample compartment or on the MP-AES should be 
wiped up immediately. The user (or other authorized personnel) 
must perform the appropriate decontamination procedure if 
hazardous material is spilled on or inside the MP-AES instrument. 

The exterior surfaces of the MP-AES instrument should be kept clean. 
All cleaning should be done with a soft cloth. If necessary, this cloth 
can be dampened with water or a mild detergent. Do not use organic 
solvents or abrasive cleaning agents. 

Before using any cleaning agent, procedure or decontamination 
method except those specified by Agilent, the user (or other 
authorized personnel) should check with your local authorized 
Agilent field service engineer or representative to confirm that the 
proposed method will not damage the equipment. 

Cleaning the MP-AES Easy Fit Torch 
To help you achieve the maximum usable life from your MP-AES Easy 
Fit torch, it is recommended that the following cleaning procedures 
are followed as soon as any discoloration appears on the outer tube 
of the torch. To maximize torch lifetime and prevent contamination, 
you should inspect the condition and cleanliness of the torch on a 
daily basis. 

CAUTION The torch is fragile. To prevent damage to the torch, always take care when 
handling or storing it. 

 

For detailed torch cleaning instructions, see “Agilent MP-AES Easy 
Fit Torch Maintenance” (part number G8000-90019) available online 
at www.agilent.com or the MP Expert Help. Click ‘Maintenance’ and 
then select ‘Cleaning the torch’.  

Store the torch in the original box or a plastic bag when not in use. 



Maintenance, Spare Parts and Troubleshooting 

50 Agilent Microwave Plasma Atomic Emission Spectrometers User’s Guide 

Cleaning the Spray Chamber 
The ‘wetting’ of a spray chamber is its ability to produce a uniform 
coating of aerosol on the internal surfaces of the spray chamber. This 
uniform coating is essential for the efficient transport of aerosol from 
the spray chamber to the plasma torch. 

The “wetting” of a spray chamber can be judged by observing the 
internal surfaces of the spray chamber while an acidified aqueous 
solution (typically 1-5%) is nebulized. A correctly ‘wetting’ spray 
chamber shows a uniform internal surface without large droplet 
formation (Figure 6).  

A poor ‘wetting’ spray chamber is usually indicated by the 
appearance of large droplets on the internal surfaces of the spray 
chamber (Figure 7) and can be caused by the analysis of water 
miscible organic samples, contamination of the spray chamber, or 
improper handling or storage. 

Figure 6. Correctly ‘wetting’ spray 
chamber with a uniform coverage 

Figure 7. Incorrectly ‘wetting’ spray 
chamber showing droplets 

A poor ‘wetting’ spray chamber can be fixed with thorough cleaning. 

For detailed spray chamber cleaning instructions, see the MP Expert 
Help. Click ‘Maintenance’ and then select ‘Cleaning the spray 
chamber’. 
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Checking the Gas Supply Tubing for Leaks 
When any gas cylinder is changed, inspect all gas hoses. Replace any 
hoses showing signs of damage or deterioration.  

Test all connections for leaks using a commercial leak testing 
solution, a mild detergent, or an electronic leak detector.  

When changing gas cylinders:  

 check all gas supply pipes and hoses for leaks 

 test the operation of all regulators 

 ensure that shutoff valves are functioning correctly 

Spare Parts 
For details on spare parts and consumables ordering information, 
refer to the Agilent Technologies website: 

www.agilent.com 

To replace the items listed below, you must use Agilent-
manufactured parts, which can be ordered online from the Agilent 
website or through your local sales representative. 

The following is a list of recommended spares to keep on hand to 
minimize downtime during maintenance and repairs: 

 Torch 

 Air inlet filter 

 Pre-optics windows 

 Spray chamber 

 Nebulizer 

 Peristaltic pump tubing 

 Drain tubing 
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Technical Support 
For technical support contact information, refer to the Agilent 
Technologies website for details: 

www.agilent.com 

Troubleshooting 
For troubleshooting information, please see the Help provided with 
the MP Expert software. 

To access it, double-click the MP Expert Help on the computer 
desktop and then click Troubleshooting. 
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In This Guide 
The guide describes the following: 

 Safety Practices and Hazards 

 Introduction  

 Installation 

 Operation 

 Maintenance, Spare Parts and 
Troubleshooting 

 

 

 

 

 

 

 

 

 
© Agilent Technologies 2011, 2013, 

2016, 2018 

Printed in Malaysia 

07/18 

*G8000-90002* 
*G8000-90002* 

G8000-90002 
Issue 4 

 



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (Adobe RGB \0501998\051)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.3
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket true
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails true
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams true
  /MaxSubsetPct 100
  /Optimize false
  /OPM 1
  /ParseDSCComments false
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts false
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages false
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages false
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K 0
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [1200 1200]
  /PageSize [595.440 841.680]
>> setpagedevice


